GUIDE TO THESIS AND DISSERTATION SERVICES TEMPLATE

About this Template

This template is meant to help guide you in creating a thesis or dissertation for Texas A&M University that conforms to the guidelines set forth in the Thesis Manual. It contains placeholder text for the preliminary pages and page 1 of the main body. The template has standard Thesis Manual margin settings, page numbers set correctly for the preliminary pages and main body (omitting the page number on the first unnumbered preliminary page), and styles to apply to your headings and subheadings.

Do not use this template as a substitute for the Thesis Manual. It is a companion piece to be used in unison with the content of the Thesis Manual. Using the template does not negate your responsibility to follow all the Thesis Manual guidelines. If you have any questions about this template or the requirements in the Thesis Manual please contact our office. We are happy to answer any questions or resolve any problems you may have.

General Tips for Template Usage

If you copy and paste sections from the template into another existing document some of the settings may be lost in the transfer. Also, be careful when pasting text from other documents into the template. Use this template as a starting off point to create your thesis. If you need to paste text from another source, paste it without formatting, and then apply the necessary styles.

How to Fill in this Template

Title Page

1. Click on the first line of placeholder text to select it, and type your title. If it goes to more than two lines, you may need to adjust the spacing of the page. The goal is to have text balanced on the page, without large uneven gaps of white space.

2. Select the type of document from the first dropdown menu. (thesis, dissertation, or record of study).
3. Click on the placeholder text and type your full name, as it appears on university records.

4. Beneath the submittal statement, select the degree you are earning (Master of Science, Master of Arts, Doctor of Philosophy, etc.) from the dropdown menu.

5. Click on the placeholder text to type your committee member’s names. Do not include their titles. If you have less committee members, delete the extra lines. If you have more committee members, hit enter on your keyboard, and then tab once to line up the new name.

6. If you have co-chairs, add their description beneath Chair of Committee. If you only have one other committee member, be sure to remove the s from Members:

   Chair of Committee, Jim Smith
   Co-Chair of Committee, James Jones
   Committee Members, Alan Smithee
   Jane Doe
   Head of Department, Liz James

7. If you are in an interdisciplinary degree program, you will need to change Head of Department to Intercollegiate Faculty Chair.

8. Select the month and year of graduation from the dropdown menus.

9. Select your major subject from the dropdown list.

10. Next to the word “Copyright,” choose the year of graduation from the drop down menu. Type your name in upper and lowercase in the placeholder text after the year.

    Abstract

1. Highlight the text of the abstract, and delete. Type your abstract in this space.

2. The abstract is formatted with text left aligned and paragraphs indented. Thesis and Dissertation Services allows for text to be formatted either left aligned or justified and paragraphs can be either be indented or not. If paragraphs are not indented, extra space must be inserted between each paragraph. Make sure the paragraph style you use in the Abstract, Dedication, and Acknowledgments matches the paragraph style of the main body text.
Dedication and Acknowledgements

These pages are optional. If you choose not to include one or both of them, delete these pages:

1. Highlight the sample text, and then type your dedication and/or acknowledgements.
2. The dedication is limited to one page; the acknowledgements can be up to four pages.

Nomenclature

This page is also optional. Delete the entire page if it is not needed.

1. To add additional abbreviations/terms, type the abbreviation on the left, then press tab once to type the meaning.

Table of Contents

The Table of Contents will be generated in this space. Leave this placeholder here until you are ready to generate the Table of Contents. Thesis and Dissertation Services recommends you wait until all content is finalized before generating a Table of Contents. See the Generating Automatic Lists section below for further instructions on how to generate and format the Table of Contents, List of Figures, and List of Tables. If you have only one figure or table, a list is not required, and you may delete the unnecessary list page. Be careful not remove section breaks when deleting. This could affect pagination.

Text

The first chapter/section includes an example title. There are two examples of the first page, one for Chapter method and one for Section method. Chose the style you prefer, and delete the other style. Once you have read the text delete it and fill in with your content. Continue typing your content, applying styles as needed until all content is inserted.
For more information on styles, see the *Use of Thesis and Dissertation Services Styles* section below. Once all content is finalized, you will want to generate a Table of Contents, List of Figures, and List of Tables. At that point, we encourage you to register for a Pre-Submittal Conference before submitting your thesis to our office for review. You can view available times and dates and register online on our website. We have several additional resources available on our website including: a Checklist for Manuscript Preparation, videos of our Online Pre-Submittal Conference, and the *Thesis Manual*. If you have any questions please feel free to contact our office.
EXAMPLES OF HEADINGS

Introduction

This section shows samples of a major heading and five levels of subheadings in the Microsoft Word Styles generated by Thesis and Dissertation Services. These are examples only. Texas A&M University graduate theses and dissertations do not have a single style for subheadings. In most theses and dissertations, chapter or major sections are divided into parts. These parts, or subsections, may be further divided into sub subsections, and so on. We generally refer to these by the term “subheadings” and, more specifically, “first, second, and third level” subheadings. The headings and subheadings categorize for the reader the organization of the thesis or dissertation. The following headings are formatting according to the styles provided by Thesis and Dissertation Services.

MAJOR HEADING

Major headings are the highest level of heading. They are centered and all caps, and should always appear at the top of the page. Major headings in your thesis include: The title of your thesis on the Title page, Abstract, Dedication (optional), Acknowledgements (optional), Nomenclature (optional), Table of Contents, List of Figures, List of Tables (only required if you have two or more figures/tables), all chapter or section titles, References, and Appendices (if applicable).

If using the Chapter Method, chapter titles should be on two lines. CHAPTER and the number on the first line then the title on a separate line. Pressing “Enter” or “Return” will break up the heading, and the style will not be applied properly. Instead, insert a manual line break by holding “Shift” and then pressing “Enter”.

CHAPTER I

INTRODUCTION
First Level Subheading

First level subheadings must be included in the Table of Contents. Some rules for ALL levels of subheadings are:

• Vertical spacing above and below each subheading needs to be consistent for each level.

• Vertical spacing within a subheading with more than one line needs to be the same as spacing of the text.

• Style and format need to match for each level (numbering is enough to differentiate the levels—if numbered they can look the same or each level can look different).

• Type size and style need to follow text.

• Capitalization needs to be consistent for each level of subheading.

The principal, or first level, subheading format should be more noticeable than the lower (second, third, etc.) level format. In general, centered headings have a greater attention value than side headings. Underlined or boldface headings, centered or side, are also attention grabbers, while those that are not underlined or boldface draw less attention. Use of underlining and boldface type together is not acceptable.

In scientific works, the numbering of sections and subsections is often used. The most common method is to give the number of the chapter (or major section), a decimal point, followed by the number of the section within the chapter. For example, 5.3 indicates the third section in Chapter V or Section 5 (even though a Roman numeral is used for the chapter number).

Second Level Subheading

Second level subheadings need to differ from first level with respect to style, unless they are numbered. If numbered, all levels of subheadings may match for style (but they do not have to). Second levels do not need to be included in the Table of Contents.
Third Level Subheading

Third level subheadings, if numbered, may match the other levels of subheadings. If unnumbered, they need to have a different style. Third levels do not need to be included in the Table of Contents.

Fourth Level Subheading

Fourth level subheadings, if numbered, may match the other levels of subheadings. If unnumbered, they need to have a different style. Fourth levels do not need to be included in the Table of Contents.

Fifth Level Subheading. Fifth level subheadings, if numbered, may match the other levels of subheadings. If unnumbered, they need to have a different style. Fifth levels do not need to be included in the Table of Contents. A paragraph run in subheading is the lowest level, and may be followed by punctuation.
USE OF THESIS AND DISSERTATION SERVICES STYLES

Introduction

Thesis and Dissertation Services template makes use of Microsoft Word’s Styles function to quickly format all the headings, subheadings, and figure/table titles in the text. These styles can be applied to existing or new text to ensure that the thesis is consistently formatted. Styles can also be used to generate an automatic Table of Contents. Using styles to format subheadings and generate a Table of Content can increase consistency and reduce the number of thesis corrections.

The template with styles is intended for advanced Microsoft Word users who are already familiar with the styles feature. For more information about using these features in Word, visit: http://bit.ly/o7XtSJ. Thesis and Dissertation Services also provides a more basic template which can be found on our website.

This section will describe the styles designed for use in Texas A&M University electronic theses and dissertations, and how to apply them to your headings and figure/table captions. How to generate and format an automatic Table of Contents is discussed in the section Generating Automatic Lists below.

Thesis and Dissertation Services does not have a single style requirement for subheadings and many variations are allowed. However, to make use of the styles function, some style choices were made for you. These styles may be modified, but all formatting should be consistent and follow the guidelines established in the Thesis Manual.
Thesis and Dissertation Services Styles

Styles are located in the Home menu/ribbon.

The styles to be used in formatting your thesis are (in descending order) Major Heading, First Level Subheading, Second Level Subheading, Third Level Subheading, Fourth Level Subheading, and Fifth Level Subheading. Use only the levels you need. If you need more than five sublevels, you can add or modify the styles or create your own additional style.

Special Considerations for Chapter Titles

If using the Chapter Method, chapter titles should be on two lines. CHAPTER and the number on the first line then the title on a separate line. Pressing “Enter” or “Return” will break up the heading, and the style will not be applied properly. Instead, insert a manual line break by holding “Shift” and then pressing “Enter”.

Limitations to Styles

The styles work best for applying type style formatting (e.g. bold, italics, centering, etc.) to areas of text. Styles will not set spacing around subheadings or correct capitalization (except for major headings). Subheadings must be consistently capitalized, and applying styles will not change sentence case to title case. The major heading style, when applied, will change the text to all caps. A subheading on a line by itself cannot include punctuation. If a subheading is followed by a period or a colon, applying a style will not fix this. See page 15 of the Thesis Manual for more information about headings and subheadings. Also, refer the section Examples of Headings to see samples of headings formatted with Thesis and Dissertation Services styles, and more information on subheadings in general.
Applying Styles

To apply styles to text:

1. Highlight the text you want the style applied to.

2. Choose the desired style from the list, and the style is applied.

Using Automatic Captions

You can also use the built in styles to add captions to your figures/tables and then generate an automatic List of Figures/List of Tables. The template has formatted the figure caption by using bold for Figure #. This is an example only, many styles are acceptable. See page 17 of the Thesis Manual for more information.

To use the automatic caption styles:

1. Insert your picture.
2. With the figure selected, go to the References tab/ribbon; click “Insert Caption.”

3. Ensure that the label and position are correct. You will need to toggle between Figure and Table to apply captions to both figures and tables. The default settings will place figure titles below and table titles above. Please consult your journal model for the proper placement of these titles. If you need to change the placement, select the appropriate option from the Position drop down menu.

4. Ensure that the figure/table number is correct (it should update every time you add a figure/table), and add any necessary punctuation in the caption portion if you choose.

5. Click OK. This will insert Figure #.
6. Type or paste the rest of the figure title after the figure number.

Figure 1. This is the figure title.

Continue applying styles and captions to all major headings, subheadings, figures and tables. Once you have finished typing or inserting content, you will need to generate a Table of Contents, List of Figures, and List of Tables. Please see the section Generating Automatic Lists for instructions on how to generate these lists.
GENERATING AUTOMATIC LISTS

Automatic Table of Contents

This section will instruct you on how to insert an automatically generated Table of Contents and List of Figures/Tables into your thesis or dissertation. Thesis and Dissertation Services recommends that you finalize your content before inserting the Table of Contents and making the formatting changes. Once you have finished writing and are ready to create an automatic Table of Contents:

1. Go to the blank Table of Contents page.
2. Place your cursor below the page heading.
3. Go to the References tab/ribbon.
4. Click Table of Contents.
5. Select insert table of contents.
You will need to decide how many levels of headings you would like to include in your table of contents. You must include a **minimum of 2** levels (Major Headings and First Level Subheadings), and you may include as many levels as you like. Word will include 3 levels as a default, so you may wish to change the number of levels included. Under the General heading in this box, click the up or down arrows to select the number of levels.

7. Click ok.

A Table of Contents will be generated, but it will still need to be formatted according to Thesis and Dissertation Services style. You will need to change the Roman numerals of the preliminary pages to lowercase numbers.
To change the Roman numerals:

8. Highlight the page number only.

9. Open the font dialog box.

10. Uncheck the box “All Caps.”

Make this change for all Roman numeral page numbers.

Other formatting corrections may be needed to conform to Thesis and Dissertation Services style. See the *Thesis Manual* for additional formatting considerations.
Automatic List of Figures/Tables

To generate an automatic List of Figures/Tables:

1. Place your cursor on the appropriate page.

2. In the references tab, click Insert Table of Figures.

3. In the dialog box, under general make sure Figures is selected (or tables if applicable) then click ok.
This will give your List of Figures/Tables the proper spacing and alignment.

<table>
<thead>
<tr>
<th>FIGURE</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Figure 1</td>
<td>The figures can be numbered consecutively throughout the thesis (1, 2, 3, 4, etc) or numbered by chapter (1-1, 1-2, 2-1, etc.). Each figure should be referred to by that number within the text, within 1 ½ pages of the figure. The figures can be put on a separate page from the text, but if they are incorporated into the text, they must be offset by at least a triple space above and below. Figures must fit within the normal page margins. Figure captions are not considered regular text, and so may be a different font size and may be single spaced.</td>
</tr>
<tr>
<td>Figure 2</td>
<td>Example of a figure</td>
</tr>
<tr>
<td>Figure 3</td>
<td>Another example of a figure. The bold part is automatically generated, the rest of the text must be entered manually. When an automatic list of figures is generated, the entire figure title will appear.</td>
</tr>
</tbody>
</table>

Other formatting corrections may be needed to conform to Thesis and Dissertation Services style. See the Thesis Manual for additional formatting considerations

**Updating the Lists**

If you make changes to your document after generating your Table of Contents, List of Figures and List of Tables, you may need to update your lists since page numbers may have changed. It is recommended that you do this before submitting your thesis to avoid receiving any additional corrections. To update your Table of Contents:

1. Right click anywhere in the body of the Table of Contents.
2. Select Update Field from the drop down menu.
3. If you have not added any new headings or subheadings, select Update page number only, and click Ok.

![Update Table of Contents](image)

4. If you have added new headings, select Update entire table.

If you are only updating page numbers, no additional formatting is required. If you need to update the entire table, you will need to make the same initial changes (lowercase Roman numerals) to the list again. The same instructions apply to updating the List of Figures/Tables.